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ASTRO.22 WINDOWS:  A REAL ASTROLOGY PROGRAM FOR REAL ASTROLOGERS!

Welcome to the best Astrology program generally available for the Windows environment.

The first Astro.22 program released was for the Atari ST range of computers in July 1990. An 
Amiga version soon followed in the latter half of 1992. The program was a resounding success on
both machines and magazine reviews gave sound ratings. The Atari Version was distributed to 
70,000 readers of the Atari Format magazine on a cover disk.

The IBM Version for DOS was released in November, 1993 - to the relief of existing customers 
who had upgraded to IBM systems.

For those of you who love the Windows environment then this latest release is for you. I trust that 
you will enjoy it.

INTRODUCTION

Congratulations on you purchase of Astro.22 Astrology for Windows. If you already have an 
interest in the subject of Astrology then you are about to spend many happy hours if front of your 
computer.

Astro.22 is a program specifically designed for the discerning Astrologer who needs a 
comprehensive range of features combined with accuracy, versatility, upgradeability and ease of 
use - at an affordable price!

This current version of Astro.22 brings the power of Windows to the Astrologer. Graphic screen 
can be scaled, copied to the Windows clipboard and pasted into other programs such as 
Paintbrush, Windows Write and any DTP package. Also text screens may be similarly ported to 
such programs and mixed with Astro.22 charts in any combination or form.

The program has been developed to meet the needs of all those who have an interest in this 
subject at whatever level. Even those who have no technical knowledge of astrology are able to 
produce charts almost immediately. Before the arrival of home computers such a task would have
required months of study and more than average aptitude for
mathematics.

From the casual student to the professional astrologer; all will enjoy the ease, speed and general 
design of the program that immediately calculates needed data: Astrologers are able to  work with
a chart from any perspective without fumbling through too many menu systems and prompts.

A total of twenty two windows may be used within the MDI (Multiple Document Interface) window 
area of Astro.22. Layered windows may be recalled to front immediately from the "Window" menu
bar.

The display of data is dynamically scaled to the dimensions of any window size, thus enabling 
multi-window views of charts and data.

The option is available for changing the colour display of the main windows and saving the design
to disk for later recall. This allows several colour displays on the same platform - if required. A 
small demo selection of colour schemes is supplied. These may be



viewed from the 'MISC - Load Colour Scheme' menu item.

Sixteen aspect types are supported and the user has complete control over the number of planets
calculated and displayed. Orb settings can also be predefined.

The program is of modular design and the student need only purchase the add-on modules that 
are suitable for present personal requirements. Further modules may be added as the need 
arises.

Full instructions for using the Astro.22 may be viewed or printed from within the program itself - 
from the Help menu bar. A full manual is also supplied on your disk in Windows Write format.

SPECIFICATION

The minimum hardware requirement is a computer with a 386 processor capable of running 
Windows 3.1x. The program will run with 2mg of memory on board but 4mg is recommended - 
8mg in the higher screen modes of 1024 x 768 plus.

The program is designed to make the most effective use of Windows and requires as much free 
memory as  possible.

As a rule of thumb:

2mg machines: - restrict to 640 x 480 using the single display window option. (Window 
                          Menu)

4mg machines: - 640 x 480  or 800 x 600 mode depending on video memory.

8mg machines: - Feel free and do as you will.

GETTING STARTED

It is expected that you are familiar with the Windows environment  and have the basic skills  of 
opening, sizing, manipulating and  closing windows; copying and loading files; using the  
clipboard etc.

TUTORIAL

    Run the Astro22w program and from the "Help" menu bar select the Getting Started 
    Tutorial  option.  This is a short tutorial covering the basics of using Astro.22. It will give 
    you a feel  for the  program and ease your path to the more advanced features.

    For U.S.A., Canadian and other world users who require the date format as 
    MM-DD-YYYY.  A vital fist step is to change the program's default date option to this 
    format:

     - From the MISC menu bar select DATE FORMAT and activate the American date 
       format.

     - Select SAVE to make this option the permanent default setting.

ON-LINE HELP

  Astro.22 for Windows has an on-line help file which is accessed via the  "Help" menu bar. 



DEMO VERSION 

A full working version of Astro.22 for Windows is integrated into the shareware verion of the 
program - Select "Run Full Demo" from the "Misc" menu.

Do note however, that date input is limited to the period 1/1/1750 to 31/12/1899.

Full intructions for using the demo program is contained in on-line help file.

DISCLAIMER OF WARRANTY

Astro.22 for Windows is supplied as is and the author assumes no liability for damages, direct or 
consequential, which may result from the use or abuse of Astro22.

Enjoy using Astro.22 for Windows.

 ============================================================

UPDATES ASTRO22 FOR WINDOWS V3.7 To V4.3.02

The following program updates have recently been incorporated into 
Astro22.

HYPERTEXT HELP FILE

A comprehensive on-line hypertext help file is now included in the 
program. It includes the full contents of the manual and can be 
accessed from the Astro22 Help Menu Bar.  

CHARACTER PROFILE

A new feature has been added to the character profile dialogue box 
that allows single attributes to be selected and displayed separately - 
such as the subjects Personality or Mental Qualities etc..

PROGRESSED CHARTS

One further option is included for all progressed charts and is activated
from the Progression menu bar:

Display Progressed to Natal

If this option is selected all subsequent progressed screen displays 
compare the progressed chart to the natal chart - Similar to the 
graphic wheel comparison screens. An orb of one degree is used for all 
calculations.



This display is compatible with the Animate option Forward & 
Backward in Time. The progressed to natal display can be incremented 
in a similar manner as any other screen display. However, do be aware 
that the increment must suit the progressed system in use. For 
example, the Progressed Chart is a one-day-for-a-year system therefore
an increment in real time of two months will update the progressed 
screen by approximately four hours.

EDITING TEXT FILES

A new group has been added to the menu bar to allow immediate 
editing of Astro22 text files relating to Character profile and Prediction. 
and Synastry. 

MAIN SCREEN DISPLAY

Vertex and East Point: The Vertex is  shown on the main screen 
display as a "V" located on the outside diameter of the wheel. The East
Point is also displayed in a similar manner  shown as an "e".

Solar and Lunar Eclipses

In the event of the current calculation  discovering a Solar or Lunar 
Eclipse the program will issue an audible warning and the  Sun and 
Moon in the main screen display will be highlighted by a colour change.

As a point of interest the closer the Sun is to the Nodes the more 
intense the Eclipse and if it is within three degrees a total eclipse is 
possible.

LOAD,  SAVE  and DELETE FILES

The above routines have been completely changed in order to provide 
a much easier selection of birth charts.

Load File: When a file category is selected a list of available charts is 
displayed in the list select box. Highlight the required file and select 
the Use button.

Save File: The new filing system uses the subjects name as input in 
the New File screen , therefore the only requirement is to select a file 
category.

Delete File: The selection dialogue box is similar to the Load File 
option  however, the  selected file is deleted  and the updated file is 
presented in the list box. The selection screen  remains active to allow 



any further files to be deleted - Choose Exit to close. 

Converting Pre 4.02 Files: Any birth files previously saved to disk 
with previous versions of Astro22 ( including files  from the MSDOS 
version of Astro22) can be converted to the new format with the 
supplied utility program convert.exe.

PRINTOUTS

Graphic Windows: A further option is given in the  selector box 
Suppress Hard Fill   
to provide compatibility with the occasional graphic card that darkens 
the zodiac wheel  when printing. 

Text Windows: The input dialogue box now allows the user to select a
preferred font for text printing.  The program will scale the fonts to the 
current CPL(Character per Line) setting if  this option is selected.

GRAPHIC ASPECT DISPLAYS

The Incounjunct is now treated as a major aspect within all screen 
displays and is
shown in line with the other aspects.

With the default colour display the inconjunct aspect is shown as a 
solid grey inter-
connecting line.  This may be changed to your own preference by 
selecting the menu option "Misc\Edit Colours". From the edit screen the
inconjunct takes the colour as set for the "Minor aspects." 

The default orb is set for two degrees of arc, however, this setting
may be changed  though the "Misc/Change Orb Settings" menu option.

Improvements and Additions to Existing Modules

PROGRESSED CHARTS: One further option is included for all progressed charts and is 
activated from the Progression menu bar - Display Progressed to Natal: If this option is 
selected all subsequent progressed screen displays compare the progressed chart to the natal 
chart - Similar to the graphic wheel comparison screens. An orb of one degree is used for all 
calculations.

HOUSE CUSPS  : The program now supports the following house systems:  Equal House, 
Koch,  Meridian, Regiomontanus, Porphyry, Morinus, Topocentric, Campanus and  
Placidus.

SEARCH ROUTINES: Three new search routines have been included in this module - Tertiary 



Search, Midpoint Search and Arabic Parts Search.

New Modules

Compatibility Profile - Synastry

The profile is designed to give a personalised reading for the user and is specially written with a 
bias for romantic, rather than general, relationships. However, the text files may be modified to 
suit any specialised use.  

To achieve the personalised readings the routine makes use of special mirror files and on-the-fly 
substitution of names and personal pronouns. This is a first for Astro22 because no other 
astrological program has this facility.

The profile is quite comprehensive and  covers all the aspects between the Current Chart 
Subjects personal planets Sun to Mars and the Resident Chart's planets Sun to Pluto plus 
Ascendant, North Node and Midheaven.  In due course an expanded interpretation will include 
inter-aspects between the impersonal planets Jupiter to Pluto and Comparative House Positions. 
An example comparative aspect is show below:

Katy's Mars Conjunct Peter's Saturn
This aspect, Katy, is better suited to a business association than to a romantic relationship. You 
probably view Peter as stuffy, old-fashioned, restrictive and unemotional. Whereas, he may 
regard you as rebellious, inconsiderate, impulsive and headstrong. This can be a difficult aspect 
to handle in a close relationship because the energies involved tend to alternate between hot and
cold. This could create feelings of frustration and futility that could block each other's positive 
expression. However, in a mature relationship this can be a very helpful alliance because Peter 
will teach you how to discipline and channel your energies into worthwhile and constructive 
endeavour. In turn you can help Peter to overcome his negative attitudes and inherent inertia.

Arabic Parts

The following routine have been included in Astro22 V4.3 for those who have an investigative 
nature willing to spend time and effort in the attempt to uncover (re-discover) the great secret 
knowledge that is locked in this astrological system. Until some dedicated research is applied to 
this grey area of astrology it will forever be shrouded in mystery. 

Astro22 can be used as an effective tool to :

1. Quickly calculate the Arabic points in any chart.
2. Show all the important planetary natal inter-aspects to the Arabic points.
3. Calculate transits aspects to the natal points in any chart.

Listed below are the points that are used by the routine  and the manner of calculation.
  
Asc+Moon-Sun           = Point of FORTUNE AND HAPPINESS
Asc+Mercury-Sun        = Point of COMMERCE
Asc+Venus-Sun          = Point of LOVE
Asc+Mars-Sun           = Point of PASSION
Asc+Jupiter-Sun        = Point of INCREASE
Asc+Saturn-Sun         = Point of FATALITY
Asc+Uranus-Sun         = Point of CATASTROPHE



Asc+Neptune-Sun        = Point of TREACHERY
Asc+Pluto-Sun          = Point of ORGANISATION
Asc+Mars-Mercury       = Point of UNDERSTANDING
Asc+Sun-Moon           = Point of SPIRIT
Asc+Saturn-Venus       = Point of FORTUNE IN MARRIAGE
Asc+Sun-Saturn         = Point of THE FATHER
Asc+Moon-Saturn        = Point of POSSESSIONS/INHERITANCE
Asc+Jupiter-Moon       = Point of MALE CHILDREN
Asc+Venus-Moon         = Point of FEMALE CHILDREN
Asc+Venus-Mars         = Point of PLAY
Asc+Mars-Saturn        = Point of SICKNESS
Asc+Seventh Cusp-Venus = Point of MARRIAGE
Asc+Jupiter-Mars       = Point of DISCORD
Asc+Eigth Cusp-Moon    = Point of DEATH
Asc+Moon-Venus         = Point of THE MOTHER
Asc+Fortuna-Saturn     = Point of SUDDEN ADVANCEMENT
Asc+Moon-Saturn        = Point of PROFESSION
Asc+Moon-Uranus        = Point of FRIENDS
Asc+Moon-Neptune       = Point of IMPRISONMENT AND SORROW

Geographical Database

This is a Pro. version of the existing geographical database of  locations for  latitude and 
longitude. The new database boasts 30,000 locations.

 

▯


